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Abstract :

IoT irrigation solution with automatic control using a soil moisture sensor and manual control through an app. On IOT platforms, which can be monitored from any location in the world, soil moisture readings and on/off times are also recorded.
Here, we're going to use the ESP8266 NodeMCU Module and DHT11 Sensor to develop an Internet of Things-based irrigation system. In addition to autonomously irrigating the ground based on the soil's moisture content, it will also send data to a special server to monitor the state of the land.

The project's objectives are:

Automate the drip irrigation system's operation while maintaining the ability to manually turn on certain zones as necessary.
Over the local network, there should be no dependency on the cloud.
be quite simple to extend to any number of zones.
Should operate autonomously by measuring the amount of soil moisture.
must be dependable yet being reasonably priced to create

Introduction of IOT

The Internet of Things, or IoT, refers to the billions of physical devices around the world that are now connected to the internet, all collecting and sharing data. Thanks to the arrival of super-cheap computer chips and the ubiquity of wireless networks, it's possible to turn anything, from something as small as a pill to something as big as an aeroplane, into a part of the IoT. Connecting up all these different objects and adding sensors to them adds a level of digital intelligence to devices that would be otherwise dumb, enabling them to communicate real-time data without involving a human being. The Internet of Things is making the fabric of the world around us smarter and more responsive, merging the digital and physical universes. 

In the broadest sense, the term IoT encompasses everything connected to the internet, but it is increasingly being used to define objects that "talk" to each other. "Simply, the Internet of Things is made up of devices – from simple sensors to smartphones and wearables – connected together," Matthew Evans, the IoT programme head at tech UK, says. 

By combining these connected devices with automated systems, it is possible to "gather information, analyse it and create an action" to help someone with a particular task, or learn from a process. In reality, this ranges from smart mirrors to beacons in shops and beyond. 

"It's about networks, it's about devices, and it's about data," Caroline Gorski, the head of IoT at Digital Catapult explains. IoT allows devices on closed private internet connections to communicate with others and "the Internet of Things brings those networks together. It gives the opportunity for devices to communicate not only within close silos but across different networking types and creates a much more connected world." 
The IoT allows objects to be sensed and/or controlled remotely across existing network infrastructure, creating opportunities for more direct integration of the physical world intocomputer-based systems, and resulting in improved efficiency, accuracy and economic benefit in addition to reduced human intervention. 
Over the past few years, IoT has become one of the most important technologies of the 21st century. Now that we can connect everyday objects—kitchen appliances, cars, thermostats, baby monitors—to the internet via embedded devices, seamless communication is possible between people, processes, and things. 
By means of low-cost computing, the cloud, big data, analytics, and mobile technologies, physical things can share and collect data with minimal human intervention. In this hyper connected world, digital systems can record, monitor, and adjust each interaction between connected things. The physical world meets the digital world—and they cooperate. 
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Figure 1: INTERNET OF THINGS
As IoT becomes more widespread in the marketplace, companies are capitalizing on the tremendous business value it can offer. These benefits include: 
· Deriving data-driven insights from IoT data to help better manage the business 
· Increasing productivity and efficiency of business operations 
·  Creating new business models and revenue streams 

· Easily and seamlessly connecting the physical business world to the digital world to drive quick time to value 


1.1 What Technologies Have Made IoT Possible?
While the idea of IoT has been in existence for a long time, a collection of recent advances in a number of different technologies has made it practical. 

• Access to low-cost, low-power sensor technology. Affordable and reliable sensors are making IoT technology possible for more manufacturers. 
• Connectivity. A host of network protocols for the internet has made it easy to connect sensors to the cloud and to other “things” for efficient data transfer. 
• Cloud computing platforms. The increase in the availability of cloud platforms enables both businesses and consumers to access the infrastructure they need to scale up without actually having to manage it all. 
• Machine learning and analytics. With advances in machine learning and analytics, along with access to varied and vast amounts of data stored in the cloud, businesses can gather insights faster and more easily. The emergence of these allied technologies continues to push the boundaries of IoT and the data produced by IoT also feeds these technologies. 
• Conversational artificial intelligence (AI). Advances in neural networks have brought natural-language processing (NLP) to IoT devices (such as digital personal assistants Alexa, Cortana, and Siri) and made them appealing, affordable, and viable for home use. 

1.2 ARCHITECTURE OF INTERNET OF THINGS
Architecture of internet Of Things contains basically 4 layers: 

· Application Layer 

· Gateway and the network layer 
· Management Service layer 
· Sensor layer 


APPLICATION LAYER: 

· Lowest Abstraction Layer 
· With sensors we are creating digital nervous system. 
· Incorporated to measure physical quantities 
· Interconnects the physical and digital world 

· Collects and process the real time information 

GATEWAY AND THE NETWORK LAYER: 

· Robust and High performance network infrastructure 
· Supports the communication requirements for latency, bandwidth or security 
· Allows multiple organizations to share and use the same network independently 





MANAGEMENT LAYER: 

· Capturing of periodic sensory data 
· Data Analytics (Extracts relevant information from massive amount of raw data) 
· Streaming Analytics (Process real time data) 
· Ensures security and privacy of data. 


SENSOR LAYER: 

· Provides a user interface for using IoT. 

· Different applications for various sectors like Transportation, Healthcare, Agriculture, Supply chains, Government, Retail etc. 

1.3 Advantages of IoT

Organizations best suited for IoT are those that would benefit from using sensor devices in their business processes.

1.3.1 Manufacturing 

Manufacturers can gain a competitive advantage by using production-line monitoring to enable proactive maintenance on equipment when sensors detect an impending failure. Sensors can actually measure when production output is compromised. With the help of sensor alerts, manufacturers can quickly check equipment for accuracy or remove it from production until it is repaired. This allows companies to reduce operating costs, get better uptime, and improve asset performance management. \
1.3.2 Automotive 

The automotive industry stands to realize significant advantages from the use of IoT applications. In addition to the benefits of applying IoT to production lines, sensors can detect impending equipment failure in vehicles already on the road and can alert the driver with details and recommendations. Thanks to aggregated information gathered by IoT-based applications, automotive manufacturers and suppliers can learn more about how to keep cars running and car owners informed. 

1.3.3 Transportation and Logistics 

Transportation and logistical systems benefit from a variety of IoT applications. Fleets of cars, trucks, ships, and trains that carry inventory can be rerouted based on weather conditions, vehicle availability, or driver availability, thanks to IoT sensor data. The inventory itself could also be equipped with sensors for track-and-trace and temperature-control monitoring. The food and beverage, flower, and pharmaceutical industries often carry temperature-sensitive inventory that would benefit greatly from IoT monitoring applications that send alerts when temperatures rise or fall to a level that threatens the product.

1.3.4 Retail 

IoT applications allow retail companies to manage inventory, improve customer experience, optimize supply chain, and reduce operational costs. For example, smart shelves fitted with weight sensors can collect RFID-based information and send the data to the IoT platform to automatically monitor inventory and trigger alerts if items are running low. Beacons can push targeted offers and promotions to customers to provide an engaging experience. 

1.3.5 Public Sector 

The benefits of IoT in the public sector and other service-related environments are similarly wide-ranging. For example, government-owned utilities can use IoT-based applications to notify their users of mass outages and even of smaller interruptions of water, power, or sewer services. IoT applications can collect data concerning the scope of an outage and deploy resources to help utilities recover from outages with greater speed. 

1.3.6 Healthcare 

IoT asset monitoring provides multiple benefits to the healthcare industry. Doctors, nurses, and orderlies often need to know the exact location of patient-assistance assets such as wheelchairs. When a hospital’s wheelchairs are equipped with IoT sensors, they can be tracked from the IoT asset-monitoring application so that anyone looking for one can quickly find the nearest available wheelchair. Many hospital assets can be tracked this way to ensure proper usage as well as financial accounting for the physical assets in each department.

1.3.7 General Safety across All Industries 

In addition to tracking physical assets, IoT can be used to improve worker safety. Employees in hazardous environments such as mines, oil and gas fields, and chemical and power plants, for example, need to know about the occurrence of a hazardous event that might affect them. When they are connected to IoT sensor–based applications, they can be notified of accidents or rescued from them as swiftly as possible. IoT applications are also used for wearables that can monitor human health and environmental conditions. Not only do these types of applications help people better understand their own health, they also permit physicians to monitor patients remotely.



1.4 APPLICATIONS

IoT applications are prebuilt software-as-a-service (SaaS) applications that can analyze and present captured IoT sensor data to business users via dashboards. 
IoT applications use machine learning algorithms to analyze massive amounts of connected sensor data in the cloud. Using real-time IoT dashboards and alerts, you gain visibility into key performance indicators, statistics for mean time between failures, and other information. Machine learning–based algorithms can identify equipment anomalies and send alerts to users and even trigger automated fixes or proactive counter measures. 
With cloud-based IoT applications, business users can quickly enhance existing processes for supply chains, customer service, human resources, and financial services. There’s no need to recreate entire business processes. 

· Modernization of home in terms of ease of access home appliances by increasing comfort and security. 
· A technology oriented home automation system based on voice commands. 
· To design an interface that would help people to reduce the amount of power they consume and help them to save money on their utility bills when they are mobile. 
· The interconnecting of a vast number of devices is permitting businesses to better address issues. 
· Sensors in everything from automobiles to medical equipment to pipelines are creating huge amounts of data that, appropriately analyzed, can provide improved operational insight. 
· While enhanced safety and better cost controls are very valuable and should not be ignored, they are only part of the eventual goals of IoT. 
· The current concentration in IoT is on the bottom line, i.e. operational efficiency and cost cutting. 

There are several application domains which will be impacted by the emerging Internet of Things. The applications can be classified based on the type of network availability, coverage, scale, heterogeneity, repeatability, user involvement and impact. 

We categorize the applications into four application domains:

· Personal and Home 
· Enterprise 
· Utilities 
· Mobile. 

There is a huge crossover in applications and the use of data between domains. For instance, the Personal and Home IoT produces electricity usage data in the house and makes it available to the electricity (utility) company which can in turn optimize the supply and demand in the Utility IoT. The internet enables sharing of data between different service providers in a seamless manner creating multiple business opportunities
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                Figure 2: APPLICATION AREAS OF INTERNET OF THINGS

IoT Applications and Scenarios of Relevance: 

“The major objectives for IoT are the creation of smart environments/spaces and self-aware things (for example: smart trans- port, products, cities, buildings, rural areas, energy, health, living, etc.) for climate, food, energy, mobility, digital society and health applications”. 

The outlook for the future is the emerging of a network of interconnected uniquely identifiable objects and their virtual representations in an Internet like structure that is positioned over a network of interconnected computers allowing for the creation of a new platform for economic growth.
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       Figure 3: Internet of Things — smart environments and smart spaces creation

At the city level, the integration of technology and quicker data analysis will lead to a more coordinated and effective civil response to security and safety (law enforcement and blue light services); higher demand for outsourcing security capabilities. 

At the building level, security technology will be integrated into systems and deliver a return on investment to the end-user through leveraging the technology in multiple applications (HR and time and attendance, customer behaviour in retail applications etc.). 
There will be an increase in the development of “Smart” vehicles which have low (and possibly zero) emissions. They will also be connected to infrastructure. Additionally, auto manufacturers will adopt more use of “Smart” materials.

1.6 How IoT Works

An IoT system consists of sensors/devices which “talk” to the cloud through some kind of connectivity. Once the data gets to the cloud, software processes it and then might decide to perform an action, such as sending an alert or automatically adjusting the sensors/devices without the need for the user. 

But if the user input is needed or if the user simply wants to check in on the system, a user interface allows them to do so. Any adjustments or actions that the user makes are then sent in the opposite direction through the system: from the user interface, to the cloud, and back to the sensors/devices to make some kind of change.

A complete IoT system integrates four distinct components: sensors/devices, connectivity, data processing, and a user interface. Below I will briefly explain each component and what it does.

1.6.1 Sensors/Devices 

First, sensors or devices collect data from their environment. This could be as simple as a temperature reading or as complex as a full video feed. 
I use “sensors/devices,” because multiple sensors can be bundled together or sensors can be part of a device that does more than just sense things. For example, your phone is a device that has multiple sensors (camera, accelerometer, GPS, etc), but your phone is not just a sensor. 
However, whether it’s a standalone sensor or a full device, in this first step data is being collected from the environment by something. 

1.6.2 Connectivity 

Next, that data is sent to the cloud, but it needs a way to get there! 
The sensors/devices can be connected to the cloud through a variety of methods including: cellular, satellite, WiFi, Bluetooth, low-power wide-area networks (LPWAN), or connecting directly to the internet via ethernet. 
Each option has tradeoffs between power consumption, range and bandwidth. Choosing which connectivity option is best comes down to the specific IoT application, but they all accomplish the same task: getting data to the cloud. 

1.6.3 Data Processing 

Once the data gets to the cloud, software performs some kind of processing on it. 
This could be very simple, such as checking that the temperature reading is within an acceptable range. Or it could also be very complex, such as using computer vision on video to identify objects (such as intruders in your house). 
But what happens when the temperature is too high or if there is an intruder in your house? That’s where the user comes in.
1.6.4 User Interface 

Next, the information is made useful to the end-user in some way. This could be via an alert to the user (email, text, notification, etc). For example, a text alert when the temperature is too high in the company’s cold storage.Also, a user might have an interface that allows them to proactively check in on the system. For example, a user might want to check the video feeds in their house via a phone app or a web browser. 

However, it’s not always a one-way street. Depending on the IoT application, the user may also be able to perform an action and affect the system. For example, the user might remotely adjust the temperature in the cold storage via an app on their phone. And some actions are performed automatically. Rather than waiting for you to adjust the temperature, the system could do it automatically via predefined rules. And rather than just call you to alert you of an intruder, the IoT system could also automatically notify relevant authorities. 

1.5 CLOUD COMPUTING 

Cloud computing is a collection of technologies that allow IT resources to be virtualized, used on an on-demand basis and delivered via the Internet as services. Cloud computing can be considered a new computing paradigm in so far as it allows the utilization of a computing infrastructure at one or more levels of abstraction, as an on-demand service made available over the Internet or other computer network. It is sold on demand, typically by the minute or the hour; it is elastic -- a user can have as much or as little of a service as they want at any given time and the service is fully managed by the provider. Because of the it’s features of greater flexibility and availability at lower cost, cloud computing is a subject that has been receiving a good deal of attention
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Figure 4: CLOUD COMPUTING
Cloud Computing can be classified into 4 types on the basis of location where the cloud is hosted:- 

• Public Cloud: A public cloud is one in which the infrastructure and other computational resources that it comprises are made available to the general public over the Internet. It is owned by a cloud provider selling cloud services and, by definition, is external to an organization.. 

• Private Cloud: A private cloud a proprietary network or a data center that supplies hosted services to a limited number of people. It may be managed either by the organization or a third party, and may be hosted within the organization’s data center or outside of it. 

• Community Cloud: A community cloud is somewhat similar to a private cloud, but the infrastructure and computational resources are shared by several organizations that have common privacy, security, and regulatory considerations, rather than for the exclusive use of a single organization. 

• Hybrid Cloud: A hybrid cloud is a composition of two or more clouds (private, community, or public) that remain unique entities but are bound together by standardized or proprietary technology that enables interoperability. 

Cloud computing utilizes three delivery models by which different types of services are delivered to the end user. The three delivery models are the SaaS, PaaS and IaaS which provide infrastructure resources, application platform and software as services to the consumer.
Software-as-a-Service:

 SAAS is defined as a software distribution model in which applications are hosted by a vendor or service provider and made available to customers over a network. Also known as “on demand” software, it is the most mature type of Cloud Computing because of its high flexibility, proven support services, enhanced scalability, reduced customer maintenance, and reduced cost due to their multi-tenet architectures. It is a model of software deployment whereby one or more applications and the computational resources to run them are provided for use on demand. Its main purpose is to reduce the total cost of hardware and software development, maintenance, and operations. Security provisions are carried out mainly by the cloud provider. The cloud subscriber does not manage or control the underlying cloud infrastructure or individual applications, except for preference selections and limited administrative application settings. 

Platform-as-a-Service: 

PAAS provides infrastructure on which software developers can build new applications or extend existing applications without requiring the need to (purchase development, QA, or production server infrastructure. It is a model of software deployment where the computing platform is provided as an on-demand service upon which applications can be developed and deployed. Its main purpose is to reduce the cost and complexity of buying, housing, and managing the underlying hardware and software components of the platform, including any needed program and database development tools. The cloud subscriber has control over applications and application environment settings of the platform. Security provisions are split between the cloud provider and the cloud subscriber. 

Infrastructure-as-a-Service:

 Infrastructure-as-a-Service (IaaS) is a model of software deployment whereby the basic computing infrastructure of servers, software, and network equipment is provided as an on-demand service upon which a platform to develop and execute applications can be established. Its main purpose is to avoid purchasing, housing, and managing the basic hardware and software infrastructure components, and instead obtain those resources as virtualized objects controllable via a service interface. The cloud subscriber generally has broad freedom to choose the operating system and development environment to be hosted Security provisions beyond the basic infrastructure are carried out mainly by the cloud subscriber. The cloud platform is used in this project is IBM Bluemix. It is an open standard, cloud based platform for building, managing and running applications of all types (web, mobile, big data, new smart devices, so on).

This work is providing solution for following main issues in the constrained devices over IoT: 
• The main objective of this work is to discuss, analyze & provide high security in Internet of Things in order to make the data and devices attached to the IoT. 
• It provides the detailed discussion of the security issues might be caused on the Internet of the things and devices attached 
• It also discusses the problem faced in providing security over the IoT as the devices connected to it are mostly resource constrained. 
• The project is oriented majorly on the security of IoT and performance application of the security measures. 

It also considers the various security algorithms applied over IoT devices their pros & cons, issues raised and discussed and provide a high performance solution to the problems raised. 

1.6 MOTIVATION 

IoT is spreading quickly as it is having many advantages and increasing the convenience for the people to avail the services on their finger tips. Since IoT is also facing many challenges, which are required to tackle to facilitate people, this work has been taken as topic of dissertation. In this work the main focus is on security & performance issues of IoT. Security has been taken as the topic, as it offers improvements in existing system which is found by applying different algorithm (in place of Kerberos, we can use time based or other light weight algorithms) and changing flow of the processing (using frequency based random time stamping) with least resources. 


1.7 OBJECTIVES 

· IoT has security challenges as multiple devices can connect to it without authentication or un-authoritatively 
· Security challenges in IoT are being dealt by the companies but still not suffice as the IoT is expanding very quickly and have large span and availability of the Internet to a wide range of persons 
· In this work, we are focusing on proposal of security algorithm implementation with greater security of connecting devices over the IoT system. 






CHAPTER – 2
 LITERATURE REVIEW

The Internet of things (stylized Internet of Things or IoT) is the internetworking of physical devices, vehicles (also referred to as "connected devices" and "smart devices"), buildings, and other items—embedded with electronics, software, sensors, actuators, and network connectivity that enable these objects to collect and exchange data. In 2013 the Global Standards Initiative on Internet of Things (IoT-GSI) defined the IoT as "the infrastructure of the information society. The IoT allows objects to be sensed and/or controlled remotely across existing network infrastructure, creating opportunities for more direct integration of the physical world into computer-based systems, and resulting in improved efficiency, accuracy and economic benefit in addition to reduced human intervention
When IoT is augmented with sensors and actuators, the technology becomes an instance of the more general class of cyber-physical systems, which also encompasses technologies such as smart grids, smart homes, intelligent transportation and smart cities. Each thing is uniquely identifiable through its embedded computing system but is able to interoperate within the existing Internet infrastructure. Experts estimate that the IoT will consist of almost 50 billion objects by 2020. Typically, IoT is expected to offer advanced connectivity of devices, systems, and services that goes beyond machine-to-machine (M2M) communications and covers a variety of protocols, domains, and applications. The interconnection of these embedded devices (including smart objects), is expected to usher in automation in nearly all fields, while also enabling advanced applications like a smart grid, and expanding to the areas such as smart cities.
"Things," in the IoT sense, can refer to a wide variety of devices such as heart monitoring implants, biochip transponders on farm animals, electric clams in coastal waters, automobiles with built-in sensors, DNA analysis devices for environmental / food / pathogen monitoring or field operation devices that assist firefighters in search and rescue operations. Legal scholars suggest looking at "Things" as an "inextricable mixture of hardware, software, data and service". These devices collect useful data with the help of various existing technologies and then autonomously flow the data between other devices. Current market examples include home automation (also known as smart home devices) such as the control and automation of lighting, heating (like smart thermostat), ventilation, air conditioning (HVAC) systems, and appliances such as washer / dryers, robotic vacuums, air purifiers, ovens or refrigerators / freezers that use Wi-Fi for remote monitoring. 
As well as the expansion of Internet-connected automation into a plethora of new application areas, IoT is also expected to generate large amounts of data from diverse locations, with the consequent necessity for quick aggregation of the data, and an increase in the need to index, store, and process such data more effectively. IoT is one of the platforms of today's Smart City, and Smart Energy Management Systems. The concept of the Internet of Things was invented by and term coined by Peter T. Lewis in September 1985 in a speech he delivered at a U.S. Federal Communications Commission (FCC) supported session at the Congressional Black Caucus 15th Legislative Weekend Conference. To begin with, we present taxonomy of the security requirements for an IoT system with respect to the different operational levels, that is to say, at the Information, Access, and Functional level [5], [6]
Information level: At this level, security should guarantee the following requirements: 
• Integrity: the received data should not been altered during the transmission. • Anonymity: the identity of the data source should remain hidden to third parties. 
• Confidentiality: data cannot be read by third parties. A trustworthy relationship should be established between IoT devices in order to exchange protected information. Replicated messages must also be recognizable. 
• Privacy: the client’s private information should not be disclosed during the data exchange. It must be hard to infer identifiable information by eavesdroppers. 
• Access level: it specifies some security mechanisms to control the access to the network. More specifically, it provides the following functionalities: 
• Access control: it guarantees that only legitimate users can access to the devices and the network for administrative tasks (e.g., remote reprogramming or control of the IoT devices and network).
• Authentication: it checks whether a device has the right to access a network and whether a network has the right to connect the device. This is likely the first operation carried out by a node when it joins a new network [7]. 
Note that devices have to provide strong authentication procedures in order to avoid security threats. For example, if all the IoT devices produced by the same manufacturer are configured with the same authentication credentials, then the hacking of one device may compromise all of the security aspects at the information level. 
• Authorization: it ensures that only the authorized devices and the users get access to the network services or resources.
 • Functional level: this level defines the security requirements in terms of the following criteria:
 • Resilience: it refers to network capacity to ensure security for its devices, even in case of attacks and failures. 

• Self organization: it denotes the capability of an IoT system to adjust itself in order to remain operational even in case of failure of some parts due to occasional malfunctioning or malicious attacks.
2.1 
Taxonomy of security attacks Besides the requirements and mechanisms at the information, access, and functional levels, it is important to understand which are the vulnerabilities and the possible attacks at the different layers of the communication stack. As explained in [8], the communication architecture of an IoT system can be roughly divided in Edge, Access, and Application layers.
 The Edge Layer provides PHY and MAC functionalities for local communications. The Access Layer grants the connection to the rest of the world, usually through a gateway device and a Middleware Layer that acts as intermediary between the IoT world and the standard Internet. 
Finally, the Application Layer takes care of the service-level data communications. In the following we present a possible taxonomy of the attacks that can target these communication layers.
 Edge Layer: One of the main threats at this level is represented by the side channel attacks [9]. The goal of these attacks is to leak information from the analysis of side signals, such as power consumption, electromagnetic emissions, and communication timing, while nodes are performing encryption procedures. Among them, the power consumption of the devices is widely exploited to guess and recover the encryption secret keys. For each encryption operation, a power trace can be captured: the power data is generally computed from the voltage difference across a resistor inserted in series with the power supply. Simple power analysis attacks try to directly interpret the power traces related to a small number of encryption rounds. Instead, the differential power analysis is a more effective and advanced approach: a bigger amount of traces are statistically analyzed in order to extract additional encryption information [10]. 
At the edge layer, IoT devices are also vulnerable to Hardware Trojan and Denial of Service (DoS) attacks that attempt to make resources unavailable to the legitimate users, e.g., by forcing the device to exit sleep (low-power consumption) mode in order to drain their batteries, or by jamming the radio communications. Also, the device package can be tampered with, e.g., to extract the cryptographic secrets of the device, modify its software to disguise a malicious node as a legacy one (camouflage), or attempt reverse engineering to figure out the details of proprietary communication protocols and possibly reserved information (as patent-covered algorithms). 
Access/Middleware Layer: at this level the main attacks are eavesdropping (also called sniffing), injection of fraudulent packets and non-authorized conversations. Even routing attacks have to be taken into account: an attacker may use this kind of attack to spoof, redirect, misdirect, or drop data packets. 
Application Layer: attacks at the application layer are quite different from the previous ones, since they directly target the software running on the devices rather than the communication technology. Such attacks may address the integrity of, e.g., machine learning algorithms, where the attacker manipulates the training process of the learning algorithm to induce misbehaviors. There can also be attacks on the login and authentication phases.
2.2 MAIN SECURITY MECHANISMS FOR IOT SERVICES 
In this section, we present standard security mechanisms that have been designed to satisfy the requirements described in the previous section.
 Encryption: 
it is the main and most important operation to ensure confidentiality during the communication. It consists in changing the actual message (plaintext) into a different one (cipher text) using a hash function that can be easily reverted only knowing a secret key. Using encryption, a possible eavesdropper can only have access to the cipher text, but should not be able to interpret the content of the message. The encryption mechanism can be symmetric or asymmetric. In symmetric encryption, the same secret key is used both for message encryption and decryption, and hence it must be known by both the sender and the receiver. In the asymmetric case, each endpoint needs to possess its own pair of keys: a public key and the associated private key, which cannot be easily derived from the public one. The public key can be known to anyone, while the private key should be kept secret. The public and private keys are designed in a way that a message encrypted with the former can only be decrypted with the latter. Therefore, to guarantee confidentiality, the message is encrypted by the sender by using the public key of the receiver, which can then recover the original message by using its own private key.
What IDE is used for Arduino?
The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text editor for writing code, a message area, a text console, a toolbar with buttons for common functions and a series of menus. It connects to the Arduino hardware to upload programs and communicate with them.
The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text editor for writing code, a message area, a text console, a toolbar with buttons for common functions and a series of menus. It connects to the Arduino hardware to upload programs and communicate with them.
Writing Sketches
Programs written using Arduino Software (IDE) are called sketches. These sketches are written in the text editor and are saved with the file extension .ino. The editor has features for cutting/pasting and for searching/replacing text. The message area gives feedback while saving and exporting and also displays errors. The console displays text output by the Arduino Software (IDE), including complete error messages and other information. The bottom righthand corner of the window displays the configured board and serial port. The toolbar buttons allow you to verify and upload programs, create, open, and save sketches, and open the serial monitor.
NB: Versions of the Arduino Software (IDE) prior to 1.0 saved sketches with the extension .pde. It is possible to open these files with version 1.0, you will be prompted to save the sketch with the .ino extension on save.
[image: IDE VERIFY File]
Verify Checks your code for errors compiling it.
[image: IDE UPLOAD File]
Upload Compiles your code and uploads it to the configured board. See uploading below for details.
Note: If you are using an external programmer with your board, you can hold down the "shift" key on your computer when using this icon. The text will change to "Upload using Programmer"
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New Creates a new sketch.
[image: IDE OPEN File]
Open Presents a menu of all the sketches in your sketchbook. Clicking one will open it within the current window overwriting its content.
Note: due to a bug in Java, this menu doesn't scroll; if you need to open a sketch late in the list, use the File | Sketchbook menu instead.
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Save Saves your sketch.
[image: IDE SERMON File]
Serial Monitor Opens the serial monitor.
Additional commands are found within the five menus: File, Edit, Sketch, Tools, Help. The menus are context sensitive, which means only those items relevant to the work currently being carried out are available.
File
· New Creates a new instance of the editor, with the bare minimum structure of a sketch already in place.
· Open Allows to load a sketch file browsing through the computer drives and folders.
· Open Recent Provides a short list of the most recent sketches, ready to be opened.
· Sketchbook Shows the current sketches within the sketchbook folder structure; clicking on any name opens the corresponding sketch in a new editor instance.
· Examples Any example provided by the Arduino Software (IDE) or library shows up in this menu item. All the examples are structured in a tree that allows easy access by topic or library.
· Close Closes the instance of the Arduino Software from which it is clicked.
· Save Saves the sketch with the current name. If the file hasn't been named before, a name will be provided in a "Save as.." window.
· Save as... Allows to save the current sketch with a different name.
· Page Setup It shows the Page Setup window for printing.
· Print Sends the current sketch to the printer according to the settings defined in Page Setup.
· Preferences Opens the Preferences window where some settings of the IDE may be customized, as the language of the IDE interface.
· Quit Closes all IDE windows. The same sketches open when Quit was chosen will be automatically reopened the next time you start the IDE.
Edit
· Undo/Redo Goes back of one or more steps you did while editing; when you go back, you may go forward with Redo.
· Cut Removes the selected text from the editor and places it into the clipboard.
· Copy Duplicates the selected text in the editor and places it into the clipboard.
· Copy for Forum Copies the code of your sketch to the clipboard in a form suitable for posting to the forum, complete with syntax coloring.
· Copy as HTML Copies the code of your sketch to the clipboard as HTML, suitable for embedding in web pages.
· Paste Puts the contents of the clipboard at the cursor position, in the editor.
· Select All Selects and highlights the whole content of the editor.
· Comment/Uncomment Puts or removes the // comment marker at the beginning of each selected line.
· Increase/Decrease Indent Adds or subtracts a space at the beginning of each selected line, moving the text one space on the right or eliminating a space at the beginning.
· Find Opens the Find and Replace window where you can specify text to search inside the current sketch according to several options.
· Find Next Highlights the next occurrence - if any - of the string specified as the search item in the Find window, relative to the cursor position.
· Find Previous Highlights the previous occurrence - if any - of the string specified as the search item in the Find window relative to the cursor position.
Sketch
· Verify/Compile Checks your sketch for errors compiling it; it will report memory usage for code and variables in the console area.
· Upload Compiles and loads the binary file onto the configured board through the configured Port.
· Upload Using Programmer This will overwrite the bootloader on the board; you will need to use Tools > Burn Bootloader to restore it and be able to Upload to USB serial port again. However, it allows you to use the full capacity of the Flash memory for your sketch. Please note that this command will NOT burn the fuses. To do so a Tools -> Burn Bootloader command must be executed.
· Export Compiled Binary Saves a .hex file that may be kept as archive or sent to the board using other tools.
· Show Sketch Folder Opens the current sketch folder.
· Include Library Adds a library to your sketch by inserting #include statements at the start of your code. For more details, see libraries below. Additionally, from this menu item you can access the Library Manager and import new libraries from .zip files.
· Add File... Adds a supplemental file to the sketch (it will be copied from its current location). The file is saved to the 
data
 subfolder of the sketch, which is intended for assets such as documentation. The contents of the 
data
 folder are not compiled, so they do not become part of the sketch program.
Tools
· Auto Format This formats your code nicely: i.e. indents it so that opening and closing curly braces line up, and that the statements inside curly braces are indented more.
· Archive Sketch Archives a copy of the current sketch in .zip format. The archive is placed in the same directory as the sketch.
· Fix Encoding & Reload Fixes possible discrepancies between the editor char map encoding and other operating systems char maps.
· Serial Monitor Opens the serial monitor window and initiates the exchange of data with any connected board on the currently selected Port. This usually resets the board, if the board supports Reset over serial port opening.
· Board Select the board that you're using. See below for descriptions of the various boards.
· Port This menu contains all the serial devices (real or virtual) on your machine. It should automatically refresh every time you open the top-level tools menu.
· Programmer For selecting a hardware programmer when programming a board or chip and not using the onboard USB-serial connection. Normally you won't need this, but if you're burning a bootloader to a new microcontroller, you will use this.
· Burn Bootloader The items in this menu allow you to burn a bootloader onto the microcontroller on an Arduino board. This is not required for normal use of an Arduino board but is useful if you purchase a new ATmega microcontroller (which normally come without a bootloader). Ensure that you've selected the correct board from the Boards menu before burning the bootloader on the target board. This command also set the right fuses.
Help
Here you find easy access to a number of documents that come with the Arduino Software (IDE). You have access to Getting Started, Reference, this guide to the IDE and other documents locally, without an internet connection. The documents are a local copy of the online ones and may link back to our online website.
· Find in Reference This is the only interactive function of the Help menu: it directly selects the relevant page in the local copy of the Reference for the function or command under the cursor.
Sketchbook
The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store your programs (or sketches). The sketches in your sketchbook can be opened from the File > Sketchbook menu or from the Open button on the toolbar. The first time you run the Arduino software, it will automatically create a directory for your sketchbook. You can view or change the location of the sketchbook location from with the Preferences dialog.
Beginning with version 1.0, files are saved with a .ino file extension. Previous versions use the .pde extension. You may still open .pde named files in version 1.0 and later, the software will automatically rename the extension to .ino.
Tabs, Multiple Files, and Compilation
Allows you to manage sketches with more than one file (each of which appears in its own tab). These can be normal Arduino code files (no visible extension), C files (.c extension), C++ files (.cpp), or header files (.h).
Before compiling the sketch, all the normal Arduino code files of the sketch (.ino, .pde) are concatenated into a single file following the order the tabs are shown in. The other file types are left as is.


Uploading
Before uploading your sketch, you need to select the correct items from the Tools > Board and Tools > Port menus. The boards are described below. On the Mac, the serial port is probably something like /dev/tty.usbmodem241 (for an UNO or Mega2560 or Leonardo) or /dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or /dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device in the ports section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct serial port and board, press the upload button in the toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on the board just before starting the upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a message when the upload is complete, or show an error.
When you upload a sketch, you're using the Arduino bootloader, a small program that has been loaded on to the microcontroller on your board. It allows you to upload code without using any additional hardware. The bootloader is active for a few seconds when the board resets; then it starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board resets).
Libraries
Libraries provide extra functionality for use in sketches, e.g. working with hardware or manipulating data. To use a library in a sketch, select it from the Sketch > Import Library menu. This will insert one or more #include statements at the top of the sketch and compile the library with your sketch. Because libraries are uploaded to the board with your sketch, they increase the amount of space it takes up. If a sketch no longer needs a library, simply delete its #include statements from the top of your code.
There is a list of libraries in the reference. Some libraries are included with the Arduino software. Others can be downloaded from a variety of sources or through the Library Manager. Starting with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in an open sketch. See these instructions for installing a third-party library.
To write your own library, see this tutorial.
Third-Party Hardware
Support for third-party hardware can be added to the hardware directory of your sketchbook directory. Platforms installed there may include board definitions (which appear in the board menu), core libraries, bootloaders, and programmer definitions. To install, create the hardware directory, then unzip the third-party platform into its own sub-directory. (Don't use "arduino" as the sub-directory name or you'll override the built-in Arduino platform.) To uninstall, simply delete its directory.
For details on creating packages for third-party hardware, see the Arduino Platform specification.
Serial Monitor
This displays serial sent from the Arduino board over USB or serial connector. To send data to the board, enter text and click on the "send" button or press enter. Choose the baud rate from the drop-down menu that matches the rate passed to Serial.begin in your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your sketch) when you connect with the serial monitor. Please note that the Serial Monitor does not process control characters; if your sketch needs a complete management of the serial communication with control characters, you can use an external terminal program and connect it to the COM port assigned to your Arduino board.
You can also talk to the board from Processing, Flash, MaxMSP, etc (see the interfacing page for details).
Preferences
Some preferences can be set in the preferences dialog (found under the Arduino menu on the Mac, or File on Windows and Linux). The rest can be found in the preferences file, whose location is shown in the preference dialog.
Language Support
[image: languagePreferences]
Since version 1.0.1 , the Arduino Software (IDE) has been translated into 30+ different languages. By default, the IDE loads in the language selected by your operating system. (Note: on Windows and possibly Linux, this is determined by the locale setting which controls currency and date formats, not by the language the operating system is displayed in.)
If you would like to change the language manually, start the Arduino Software (IDE) and open the Preferences window. Next to the Editor Language there is a dropdown menu of currently supported languages. Select your preferred language from the menu, and restart the software to use the selected language. If your operating system language is not supported, the Arduino Software (IDE) will default to English.
You can return the software to its default setting of selecting its language based on your operating system by selecting System Default from the Editor Language drop-down. This setting will take effect when you restart the Arduino Software (IDE). Similarly, after changing your operating system's settings, you must restart the Arduino Software (IDE) to update it to the new default language.
Boards
The board selection has two effects: it sets the parameters (e.g. CPU speed and baud rate) used when compiling and uploading sketches; and sets and the file and fuse settings used by the burn bootloader command. Some of the board definitions differ only in the latter, so even if you've been uploading successfully with a particular selection you'll want to check it before burning the bootloader. You can find different boards here.
Arduino Software (IDE) includes the built in support for the boards in the following list, all based on the AVR Core. The Boards Manager included in the standard installation allows to add support for the growing number of new boards based on different cores like Arduino Due, Arduino Zero, Edison, Galileo and so on.
· Arduino Yún An ATmega32u4 running at 16 MHz with auto-reset, 12 Analog In, 20 Digital I/O and 7 PWM.
· Arduino Uno An ATmega328P running at 16 MHz with auto-reset, 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino Diecimila or Duemilanove w/ ATmega168 An ATmega168 running at 16 MHz with auto-reset.
· Arduino Nano w/ ATmega328P An ATmega328P running at 16 MHz with auto-reset. Has eight analog inputs.
· Arduino Mega 2560 An ATmega2560 running at 16 MHz with auto-reset, 16 Analog In, 54 Digital I/O and 15 PWM.
· Arduino Mega An ATmega1280 running at 16 MHz with auto-reset, 16 Analog In, 54 Digital I/O and 15 PWM.
· Arduino Mega ADK An ATmega2560 running at 16 MHz with auto-reset, 16 Analog In, 54 Digital I/O and 15 PWM.
· Arduino Leonardo An ATmega32u4 running at 16 MHz with auto-reset, 12 Analog In, 20 Digital I/O and 7 PWM.
· Arduino Micro An ATmega32u4 running at 16 MHz with auto-reset, 12 Analog In, 20 Digital I/O and 7 PWM.
· Arduino Esplora An ATmega32u4 running at 16 MHz with auto-reset.
· Arduino Mini w/ ATmega328P An ATmega328P running at 16 MHz with auto-reset, 8 Analog In, 14 Digital I/O and 6 PWM.
· Arduino Ethernet Equivalent to Arduino UNO with an Ethernet shield: An ATmega328P running at 16 MHz with auto-reset, 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino Fio An ATmega328P running at 8 MHz with auto-reset. Equivalent to Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328P, 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino BT w/ ATmega328P ATmega328P running at 16 MHz. The bootloader burned (4 KB) includes codes to initialize the on-board Bluetooth® module, 6 Analog In, 14 Digital I/O and 6 PWM..
· LilyPad Arduino USB An ATmega32u4 running at 8 MHz with auto-reset, 4 Analog In, 9 Digital I/O and 4 PWM.
· LilyPad Arduino An ATmega168 or ATmega132 running at 8 MHz with auto-reset, 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328P An ATmega328P running at 16 MHz with auto-reset. Equivalent to Arduino Duemilanove or Nano w/ ATmega328P; 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino NG or older w/ ATmega168 An ATmega168 running at 16 MHzwithout auto-reset. Compilation and upload is equivalent to Arduino Diecimila or Duemilanove w/ ATmega168, but the bootloader burned has a slower timeout (and blinks the pin 13 LED three times on reset); 6 Analog In, 14 Digital I/O and 6 PWM.
· Arduino Robot Control An ATmega328P running at 16 MHz with auto-reset.
· Arduino Robot Motor An ATmega328P running at 16 MHz with auto-reset.
· Arduino Gemma An ATtiny85 running at 8 MHz with auto-reset, 1 Analog In, 3 Digital I/O and 2 PWM.










CHAPTER - 3
PROPOSED WORK


IoT Data Protocols
IoT data protocols are used to connect low-power IoT devices. They provide communication with hardware on the user side – without the need for any internet connection.
The connectivity in IoT data protocols and standards is through a wired or cellular network. Some examples of IoT data protocols are:
MQTT (Message Queuing Telemetry Transport) 
An MQTT (Message Queuing Telemetry Transport) is a lightweight IoT data protocol. It features a publisher-subscriber messaging model and allows for simple data flow between different devices.
MQTT’s main selling point is its architecture. Its genetic make-up is basic and lightweight and, therefore, it’s able to provide low power consumption for devices. It also works on top of a TCP/IP protocol.
IoT data protocols were designed to tackle unreliable communication networks. This became a need in the IoT world due to the increasing number of small, cheap, and lower-power objects that have appeared in the network over the past few years.
Despite MQTT’s wide adaptation – most notably as an IoT standard with industrial applications – it doesn’t support a defined data representation and device management structure mode. As a result, the implementation of data and device management capabilities is entirely platform- or vendor-specific.
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CHAPTER - 4
Implementation with Result and Analysis
Steps and Procedure for performing the Project
Entire project is based over the “Thingspeak IOT Cloud platform”. Below are some of the key features of this IOT platform : 
· Public/Private view
· Channel Settings
· API-keys
· MATLAB Analysis
· Add Visualizations


[image: ]
                    Snapshot of Thingspeak IOT Cloud

1) Open the browser and search for THINGSPEAK IOT CLOUD in the search bar and look for the website www.thingspeak.com

2) Create a MathWorks account to access all the features of ThingSpeak
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Components  
· Esp8266 NODE MCU
The NodeMCU is a popular development board based on the ESP8266. It features not only the ESP12 Module, which contains the ESP8266. But it also comes with a USB connector and breadboard-friendly pins, to make it easy for you to test and develop projects for the ESP8266.         


[image: 1. ESP8266 NodeMCU]

· PCB 
A printed circuit board, or PCB, is used to mechanically support and electrically connect electronic components using conductive pathways, tracks or signal traces etched from copper sheets laminated onto a non-conductive substrate.  

[image: How to Design a PCB Layout - Circuit Basics]




· DHT-11 Sensor                                                                                         
The DHT-11 Digital Temperature And Humidity Sensor is a basic, ultra low-cost digital temperature and humidity sensor. It uses a capacitive humidity sensor and a thermistor to measure the surrounding air and spits out a digital signal on the data pin (no analog input pins needed).

[image: DHT 11 Temperature Humidity Sensor Module, 5.5v Dc, Serial(single-wire  Two-way), Rs 150/piece | ID: 13964138088]


· USB Data Cable (2.0)
Supporting three speed modes (1.5, 12 and 480 megabits per second), USB 2.0 supports low-bandwidth devices such as keyboards and mice, as well as high-bandwidth ones like high-resolution webcams, scanners, printers and high-capacity storage systems.
[image: Amazon.com: Amazon Basics USB 2.0 Cable - A-Male to Mini-B Cord - 6 Feet  (1.8 Meters)Black- 1-Pack : Electronics]


[image: IoT Based Smart Agriculture ESP8266]


· Capacitive Soil Moisture Sensor
Soil moisture sensors measure the water content in the soil and can be used to estimate the amount of stored water in the soil horizon. 


.[image: xcluma Soil Moisture Meter Soil Humidity Sensor Water Sensor UNO Respberry  : Amazon.in: Industrial & Scientific]

· DC 3-6V Micro Submersible Mini Water Pump
This DC 3-6 V Mini Micro Submersible Water Pump is a low-cost, small-size Submersible Pump Motor that can be operated from a 2.5 ~ 6V power supply. It can take up to 120 liters per hour with a very low current consumption of 220mA.
[image: Buy 3 -6V Mini Submersible Water Pump Online at the Best Price]


· Relay Module

A power relay module is an electrical switch that is operated by an electromagnet. 

[image: Addicore 1 Channel Relay Module 10A]



Setting Up Thingspeak Server

Step 1: Visit https://thingspeak.com/ and create your account by filling up the details.
Step 2: Create a New Channel by Clicking on “Channel” & fill up the following details as shown in the image below.

[image: https://how2electronics.com/wp-content/uploads/2020/08/Thingspeak-Agricuture-Setup-467x360.jpg]

Step 3: Click on API Key, you will see the “Write API Key“. Copy the API Key. This is very important, it will be required in Code Part.

[image: ]
               API-KEY of the project : 23O35SDOSRKMQ6LF
Note: API – KEY  is different for each console
Step 4: You can click on the “Private View” & customize the display window as you want. So, that’s all from the Thingspeak Setup Part. Now let us move to the programming Part.

· Arduino IDE – The code editor in which all the codes of this project needed to be pasted to run the project.

[image: ]

Website to download the Arduino IDE
https://www.arduino.cc/en/software


Source Code/Program
The Source Code for IoT Smart Agriculture & Automatic Irrigation System with ESP8266 is very simple. The code can be directly uploaded to the NOdeMCU Board. But before that make sure to add OLED Display 
Library mentioned below
1. Adafruit GFX Library: 
2. SSD1306 Library: 
In the below code part, change the Thingspeak API Key, WiFi SSID & Password. The most important part of this code is the calibration of the Soil Moisture Sensor Value like AirValue and WaterValue. To learn how to calibrate and get the correct reading follow this post: Calibrating Soil Moisture Sensor Value. Please!, do not skip this step. This may result in getting the wrong soil moisture value and sometimes may result in continuous turning ON of the motor.


Code To Run the Project :              
#include <ESP8266WiFi.h>
#include <SPI.h>
#include <Wire.h>
#include <Adafruit_GFX.h>
#include <Adafruit_SSD1306.h>
#include <DHT.h>  // Including library for dht
#define SCREEN_WIDTH 128 // OLED display width, in pixels
#define SCREEN_HEIGHT 64 // OLED display height, in pixels
#define OLED_RESET -1 // Reset pin # (or -1 if sharing Arduino reset pin)
#define DHTPIN D4          //pin where the dht11 is connected
DHT dht(DHTPIN, DHT11);
String apiKey = "NWFHXJ5K6T15HIAD"; // Enter your Write API key from ThingSpeak
const char *ssid = "IOT";     // replace with your wifi ssid and wpa2 key
const char *pass = "12345678";
const char* server = "api.thingspeak.com";
Adafruit_SSD1306 display(SCREEN_WIDTH, SCREEN_HEIGHT, &Wire, OLED_RESET);
const int AirValue = 790;   //you need to replace this value with Value_1
const int WaterValue = 390;  //you need to replace this value with Value_2
const int SensorPin = A0;
int soilMoistureValue = 0;
int soilmoisturepercent=0;
int relaypin = D0;
WiFiClient client;
void setup() {
  Serial.begin(115200); // open serial port, set the baud rate to 9600 bps
  display.begin(SSD1306_SWITCHCAPVCC, 0x3C); //initialize with the I2C addr 0x3C (128x64)
  display.clearDisplay();
  pinMode(relaypin, OUTPUT);
  dht.begin();
  WiFi.begin(ssid, pass);
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
    Serial.println("");
    Serial.println("WiFi connected");
    delay(4000);
}  
void loop()
{
  float h = dht.readHumidity();
  float t = dht.readTemperature();
  Serial.print("Humidity: ");
  Serial.println(h);
  Serial.print("Temperature: ");
  Serial.println(t);
  soilMoistureValue = analogRead(SensorPin);  //put Sensor insert into soil
  Serial.println(soilMoistureValue);
  soilmoisturepercent = map(soilMoistureValue, AirValue, WaterValue, 0, 100);
if(soilmoisturepercent > 100)
{
  Serial.println("100 %");
 
  display.setCursor(0,0);  //oled display
  display.setTextSize(2);
  display.setTextColor(WHITE);
  display.print("Soil RH:");
  display.setTextSize(1);
  display.print("100");
  display.println(" %");
  display.setCursor(0,20);  //oled display
  display.setTextSize(2);
  display.print("Air RH:");
  display.setTextSize(1);
  display.print(h);
  display.println(" %");
  display.setCursor(0,40);  //oled display
  display.setTextSize(2);
  display.print("Temp:");
  display.setTextSize(1);
  display.print(t);
  display.println(" C");
  display.display();
  delay(250);
  display.clearDisplay();
}
else if(soilmoisturepercent <0)
{
  Serial.println("0 %");
  display.setCursor(0,0);  //oled display
  display.setTextSize(2);
  display.setTextColor(WHITE);
  display.print("Soil RH:");
  display.setTextSize(1);
  display.print("0");
  display.println(" %");
  display.setCursor(0,20);  //oled display
  display.setTextSize(2);
  display.print("Air RH:");
  display.setTextSize(1);
  display.print(h);
  display.println(" %");
  display.setCursor(0,40);  //oled display
  display.setTextSize(2);
  display.print("Temp:");
  display.setTextSize(1);
  display.print(t);
  display.println(" C");
  display.display();
  delay(250);
  display.clearDisplay();
}
else if(soilmoisturepercent >=0 && soilmoisturepercent <= 100)
{
  Serial.print(soilmoisturepercent);
  Serial.println("%");
  display.setCursor(0,0);  //oled display
  display.setTextSize(2);
  display.setTextColor(WHITE);
  display.print("Soil RH:");
  display.setTextSize(1);
  display.print(soilmoisturepercent);
  display.println(" %");
  display.setCursor(0,20);  //oled display
  display.setTextSize(2);
  display.print("Air RH:");
  display.setTextSize(1);
  display.print(h);
  display.println(" %");
  display.setCursor(0,40);  //oled display
  display.setTextSize(2);
  display.print("Temp:");                                                                                                 
[image: ]
                                                                   DASHBOARD-THINGSPEAK

Testing & Results

This water pump need to be fully submerged in water. The outlet pipe is kept in a field for irrigation. Similarly soil Moisture sensor is dipped in soil. As soon as you power on the device, the OLED will start displaying the Soil Humidity, Air Humidity, and also Air Temperature. It 
[image: ]
                          RealTime Pictures Of the Project                                        
shows the real-Time Data. When the soil moisture content is reduced the water pumps turn on and irrigate the field until the required moisture is achieved. You can check its full working here in this video below. You can monitor the data online from any part of the world using Thingspeak Server. To do that, go to the private view of the Thingspeak server. You can check the soil Moisture, Humidity, and Temperature as well as relay status.





Chapter-5
Conclusion &Future Work
_____________________________________________________________________________
It can provide high accuracy water supply and avoid water from wastage. Due to automatically handling, user requires less man power. With the help of the sensors, it can accurately determine the soil moisture levels. It can easily detect and control the temperature, humidity, solar radiation using sensors
This smart irrigation system extends watering time for plants, and provides ideal growth condition. It saves time and timer delay as per the environmental condition can be added for automatic watering. This smart irrigation system can be adjusted and modified according to the changing environment.
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What are Communication Models in loT ?

¢ Communication models determine the mechanism or
the manner in which data or information is
exchanged or transferred or shared between various
devices in the IoT network.

* There are various types of communication models
that are used for data exchange jin the IoT network.
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* The various communication models that are used in
IoT are:

W Publish - Subscribe





image15.png
Publisher

Produces

data
related to

various
topics

data related
to Topic- 1

data related
to Topic- 2

Subscribers

Consumers -
Aand B

Topic - 2
Subscribers





image16.png
This communication model consists of three parties:
Publishers, Subscribers and Brokers.

Publishers are data producers, Subscribers are data
consumers and Brokers are data managers.

Publishsers are not aware of the Suberibers.
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* Subscribers subscribe to various topics according to
their interest and brokers/managers provide data to
them depending upon their choice of subscription.

* The publishers and subscribers are connected by the
broker, which acts as the connecting link.
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Abstract :

 

 

IoT irrigation solution with automatic control using a soil moisture sensor and manual control 

through an app. On IOT platforms, which can be monitored from any location in t

he world, soil 

moisture readings and on/off times are also recorded.

 

Here, we're going to use the ESP8266 NodeMCU Module and DHT11 Sensor to develop an 

Internet of Things

-

based irrigation system. In addition to autonomously irrigating the ground 

based on the soil's moisture content, it will also send data to a special serve

r to monitor the state 

of the land.

 

 

The project's objectives are:

 

 

Automate the drip irrigation system's operation while maintaining the ability to manually turn on 

certain zones as necessary.

 

Over the local network, there should be no dependency on the clo

ud.

 

be quite simple to extend to any number of zones.

 

Should operate autonomously by measuring the amount of soil moisture.

 

must be dependable yet being reasonably priced to create

 

 

Introduction of 

IOT

 

 

The Internet of Things, or IoT, refers to the billions of physical devices around the world that are 

now connected to the internet, all collecting and sharing data. Thanks to the arrival of super

-

cheap computer chips and the ubiquity of wireless netwo

rks, it's possible to turn anything, from 

something as small as a pill to something as big as an aeroplane, into a part of the IoT. 

Connecting up all these different objects and adding sensors to them adds a level of digital 

intelligence to devices that wo

uld be otherwise dumb, enabling them to communicate real

-

time 

data without involving a human being. The Internet of Things is making the fabric of the world 

around us smarter and more responsive, merging the digital and physical universes. 

 

 

In the broades

t sense, the term IoT encompasses everything connected to the internet, but it is 

increasingly being used to define objects that "talk" to each other. "Simply, the Internet of 

Things is made up of devices 

–

 

from simple sensors to smartphones and wearables 

–

 

connected 

together," Matthew Evans, the IoT programme head at tech UK, says. 

 

 

